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The predominant species of powdery mildew in the Cucurbitaceae is Podosphaera xanthii. However, there is little informa-
tion on the epidemiology of this disease in Mexico despite its importance. As a first assay, we explore the applicability of a quan-
titative technique to estimate differences in the severity of disease caused by P. xanthii on leaves of Cucurbitaceae. We obtained 
two samples from different hosts: cultivated (Cucurbita pepo) and wild (C. radicans) cucurbits. Conidia were inoculated onto the 
leaves of growing plants of seven cucurbit species. We used the ImageJ program to quantify the infected area for each leaf as the 
sum of several polygons. The severity of the infection was calculated as the percentage of the infected foliar area. The two inoc-
ula of P. xanthii were pathogenic in five of seven inoculated cucurbits. Our analyses of variance to compare the variation of the 
percentage values among susceptible hosts revealed different levels of severity. This result indicates that this is a promising 
method to quantitatively compare differences in disease severity of different strains or hosts of powdery mildews.
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The main species of cucurbits cultivated in Mex-
ico are squash (Cucurbita spp.), cucumber (Cucumis 
sativus L.), melon (Cucumis melo L.), watermelon 
(Citrullus lanatus (Thunb.) Matsum. & Nakai) and 
‘chayote’ (Sechium edule (Jacq.) Sw.) (SIAP 2020). 
An important percentage of cucurbit crops are for 
local consumption. At the same time, the export of 
these cucurbits in 2018 represented profits of more 
than 699 million dollars for Mexico (SADER-SIAP 
2019). A common and severe disease in cucurbits 
(Lebeda et al. 2018) is powdery mildew caused by 
different species of Erysiphales (Ascomycota). It is 
characterized by the presence of mycelial growth 
and conidia with a white and powdery appearance, 
present in patches or completely covering leaves 
and stems, sometimes appearing on flowers and 
fruits (Braun & Cook 2012). Erysiphales infection 
stunts growth and promotes premature desiccation 
of the leaves, and consequently, decreases the qual-
ity and yield of the fruits (Lebeda et al. 2016). Two 
main species of fungi, Golovinomyces orontii (Cast-
agne) V.P. Heluta and Podosphaera xanthii (Cast-
agne) U. Braun & Shishkoff, have been identified 
among the causes of powdery mildew (Křístková et 

al. 2009, Braun et al. 2019). Both Erysiphales spe-
cies are present in all cucurbits producing areas of 
the world (Pirondi et al. 2015, 2016). 

The pathogenicity and virulence of Podosphaera 
xanthii isolates are highly variable (Bardin et al. 
1997, Rabelo et al. 2017, Lebeda et al. 2018). Several 
pathotypes have been defined according to their in-
fective capacity on differential hosts, which include 
the species and genera of cucurbits with greater ag-
ricultural importance (Bardin et al. 1997, Lebeda et 
al. 2008). Various physiological races have been de-
termined based on the levels of virulence or severi-
ty. Severity levels are evaluated by inoculating Cu-
cumis melo (melon) plants, whose varieties have 
genotypes of differential resistance to the pathogen 
(Lebeda et al. 2016, 2018, Rabelo et al. 2017, Hong et 
al. 2018). The severity of the disease is estimated 
based on the percentage of the foliar area affected 
by the powdery mildew. Although the severity can 
be calculated by visual examination (Lebeda et al. 
2004), the results present errors and inconsistencies 
since they depend a lot on the experience and sub-
jectivity of the evaluator(s) (Barbedo 2016, Bock et 
al. 2020). 
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Several quantitative techniques have been 
adapted to assess the severity of plant diseases 
(Singh et al. 2020). A group of methods uses the 
properties of pixels in digital image analysis by au-
tomatically segmenting islands of pixels, in the vis-
ible spectra (Barbedo 2013, Hitimana & Oubong 
2014) and in the invisible (Schneider et al. 2012, Al-
Qarallah et al. 2017). This strategy has been used to 
quantify the severity of P. xanthii (as Sphaerotheca 
fuliginea) infection in cucumber leaves (C. sativus) 
(Kampmann & Hansen 1994). Another group of 
methods is based on the measurement of infected 
areas. In this case, the areas to be measured are de-
limited manually and then the number of pixels in 
that area is quantified. For example, to measure the 
susceptibility of soybeans to infection by Xan-
thomonas campestris pv. glycines (Nakano) natural 
colours were analysed in digital images with the 
ImageJ program. The “color threshold” function 
was  used to delimit islands of pixels of the same 
colour and then, areas of various colours were cal-
culated with the “measure” function (Matsunaga et 
al. 2017). In another example, colour recognition 
was performed automatically to calculate the leaf 
area of barley (Hordeum vulgare L.) infected by 
Blumeria graminis (DC.) Speer. Photographs were 
obtained with polarized light and an algorithm was 
used for the analysis of the images by means of the 
Quantimet program (Newton 1989). When it is not 
so easy to delineate the coloured pixels, then the in-
fected areas are digitally coloured. With this ap-
proach, the severity of infection of strains of Po-
dosphaera clandestina (Wallr.) Lév. was quantified 
on cherry leaves [Prunus avium (L.) L.] with the 
SigmaScan Pro program (Olmstead et al. 2001). In 
digital images, the manually coloured area was 
measured with the “trace area” and “measure area” 
functions (Olmstead et al. 2001). In another case, 
the areas were first physically drawn and then, digi-
tal images were obtained to quantify the infection 
by Colletotrichum destructivum O’Gara in tobacco 
leaves (Nicotiana benthamiana Domin). Percentag-
es of the diseased leaf area were estimated with the 
Scion Image program (Wijekoon et al. 2008). 

As a first assay, the goal of this study was to ex-
plore the applicability of a quantitative technique 
based on area measurements to estimate differences 
in the severity of disease caused by P. xanthii on 
leaves of several cucurbits. In this exploratory 
study, we used digital images of the leaves to direct-
ly delimit several polygons and then calculate the 
sum of the infected areas with the ImageJ program 
(Schneider et al. 2012). The strategy of demarcation 
of polygons has not been used with this pathogen 

previously, so we tested this quantitative technique, 
to explore whether there are differences in the 
pathogenicity and severity of infection of two 
strains of P. xanthii.

Material and methods

Plant material 

Ten seeds of each of the seven host varieties and 
species of cucurbits were sown: C. pepo (var. ‘zuc-
chini’ and var. ‘criolla’), Cucurbita ficifolia Bouché, 
Cucurbita okeechobeensis subsp. martinezii (L.H. 
Bailey) Walters & Deck.-Walt., C. sativus, C. lanatus 
and S. edule (Tab. 1). Each plant grew in a plastic pot 
(2070 cm3 capacity) with approximately 1700–1800 
cm3 of oak forest leaf soil [Sandy Loam (17.24 % clay, 
25.44 % silt, 57.32 % sand), pH 6.41]. The plants (n 
= 70) developed at room temperature between 14–28 
°C (CONAGUA 2021) and natural light. The patho-
genicity tests were carried out by inoculating healthy 
plants between 35 and 40 days old.

Inoculum 

Two samples of Podosphaera xanthii (M1 and 
M2) were used for the inoculum. The M1 inoculum 
came from a crop of ‘calabacita criolla’ (C. pepo) 
grown in a backyard in central-western Mexico 
(Chilchota, Michoacán). M2 was obtained from the 
leaves of a wild ‘calabacita’ (Cucurbita radicans 
Naudin) growing as a weed in the same geographi-
cal area (Purépero, Michoacán). To perform the 
pathogenicity test, 10 infected leaves were collected 
from each host plant. The two sets of infected leaves 
were transported to the laboratory in polyethylene 
bags and kept at room temperature between 23–
25  ºC. The somatic and reproductive structures of 
the fungi were observed in an optical microscope, to 
corroborate the identity of P. xanthii, by the pres-
ence of fibrosin bodies and conidial chains (Braun 
& Cook 2012). Fungal vouchers for M1 (on leaves of 
Cucurbita pepo; Loc. Ichán, Mpio. Chilchota, Micho-
acán, México. 11 Sep. 2020, R. Gregorio-Cipriano 
694) and M2 (on leaves of Cucurbita radicans; Loc. 
El Plan, Mpio. Purépero, Michoacán. Mexico, 10 Sep. 
2020, R. Gregorio-Cipriano 693) were deposited in 
the mycological collection in XAL.

Pathogenicity tests 

Each of the two inocula of P. xanthii (M1 and 
M2) were used to infect two to three plants (two to 
four leaves per plant) of the seven host species or 
varieties of cucurbits. Each inoculum was seeded in 
a subtotal of 56 leaves. In total 112 leaves were in-
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oculated. Inoculation was carried out by transfer-
ring conidia along the mid vein of the adaxial side 
of healthy leaves from diseased leaves with a brush 
(Fonseca et al. 2019). The age of the leaves ranged 
from the uppermost young leaves, to the medium-
aged leaves from the middle of the shoot. Subse-
quently, the plants were covered with a polyethyl-
ene bag for 24 h to maintain high relative humidity 
and ambient temperature between 23–25 ºC, to al-
low the establishment of the pathogen. As a nega-
tive control, two or three plants of each species and 
variety were placed without inoculum under the 
same conditions. After 24 h, the inoculated and 
non-inoculated plants were placed in a 56 × 73 × 
195 cm portable greenhouse without a fan (Home 
Complete 514537FXW), at a temperature of 14–
39 °C and a relative humidity of 45–99 % (Hydrom-
eter and AcuRite 00613 Digital Thermometer). 
These conditions prevented the exposure of the 
plants to other sources of Erysiphales inoculum or 
other pathogens or pests, or the dispersal of the co-
nidia within the greenhouse. Natural ventilation 
was allowed to avoid excess moisture, while being 
protected from gusts of wind or rain. The patho-
genicity of M1 and M2 in the seven host species or 
varieties of cucurbits was determined by observing 
the presence or absence of powdery mildew colo-
nies 15 days after inoculation.

In a separate experiment, we inoculated 12 
leaves to estimate the range of conidia transferred 
by the brushing method. Variation in the inoculum 
brushed from a diseased leaf to the healthy leaf was 
quantified by counting the conidia in a total of 36 

samples. Samples were obtained by applying a 
transparent tape onto the diseased (brushed) host 
leaf and removing it with the conidia attached to 
the sticky surface of the tape. For each leaf, we 
counted the numbers of conidia in three separate 
squares (1x1 cm), under a light microscope. 

Measurement of areas 

Eighty digital photographs of leaves of infected 
hosts were obtained. A millimetre sheet was placed 
as a background for reference to the scale. The Im-
ageJ program (Schneider et al. 2012) was used to 
quantify total leaf areas, the sum of infected areas, 
and the area of a scale. Areas were quantified by 
counting the pixels within the delimited perimeters 
of the leaf and of the colonies of powdery mildew 
infection (Fig. 1, and Supplementary Fig. 1). The im-
ages were prepared to improve the visibility of the 
edges of the white spots of the powdery mildew by 
using the function “Image> Adjust> Brightness / 
contrast> Auto”. In the main menu “Analyze> Set 
Measurements> Area, Display Label” was selected 
to delineate three areas separately. First, in each im-
age, a box was delimited with the “Rectangle” tool 
to measure the area for the scale. Second, the sepa-
rate polygons of all the powdery mildew spots on a 
leaf were delimited with the “Free hand selections” 
tool to measure the infected area. Third, the outline 
of the leaf was delimited with the “Free hand selec-
tions” tool to measure the total leaf area. Measure-
ments of the scale area, the powdery mildew and 
the whole leaf were made with the function in the 

Fig. 1. A) Cucurbita ficifolia leaf with powdery mildew. The white line indicates the delimitation of the perimeter of the leaf. 
B) Delimitation of the infection area of Podosphaera xanthii.
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main menu “Analyze> Measure”. The same proce-
dure of three separate measurements was applied 
for each image. The three areas were recorded in 
pixels and the conversion to millimetres was subse-
quently carried out using the number of pixels in 
the 1 cm square as a scale reference in each image. 
The values of the area of the spots and the total area 
of the leaves were used to calculate the percentage 
of infection (PI) of each leaf.

Statistical analysis

Variation of the inoculum brushed from a dis-
eased leaf to the healthy leaf was inspected with the 
univariate summary statistics and the Shapiro-
Wilk test for normality from the numbers of conidia 
in 36 samples, using PAST statistical package 
(Hammer et al. 2001). This analysis would provide 
insight if the inoculum transferred to infect the 
leaves was consistent among the seven hosts in the 
comparative experiment. 

The host plants, jubilee watermelon (Citrullus 
lanatus) and smooth green ‘chayote’ (Sechium ed-
ule) did not show symptoms or signs of powdery 
mildew. Therefore, they were not considered in the 
statistical comparisons of the severity values. The 
variation of the infection percentage values (PI) of 
each leaf was examined to reveal differences in the 
severity of the M1 and M2 inocula using analysis of 
variance in the PAST statistical package (Hammer 
et al. 2001). A first analysis compared the severity 
levels of the P. xanthii inoculum from the cultivated 
host (M1, C. pepo) among the five infected hosts. The 
comparison of the means and variances of the PI 
values was carried out with an analysis of variance 
(ANOVA), with the option “several sample test”. 
Tukey’s test was used for the paired comparison of 
the five PI averages from M1. In the same way, the 

five severity levels (PI) of the inoculum of P. xanthii 
from the wild host (M2, C. radicans) were compared 
with a second analysis of variance using the same 
option “several sample test”. These two analyses 
made it possible to evaluate whether the severity 
caused by M1 and M2 is the same or not, depending 
on the five hosts.

To reveal if there are differences in the severity 
of the M1 or M2 inoculates of P. xanthii, we also 
compared the two values of PI in the same species 
or variety of infected cucurbit. An analysis of vari-
ance (ANOVA) of the two PI values was carried out, 
separately for each inoculated species of cucurbits. 
The five paired comparisons of the PI values, by M1 
and by M2, were estimated with an analysis of vari-
ance using the “two-sample test” option in PAST.

Results

Pathogenicity tests

Univariate summary statistics from the numbers 
of conidia in 36 samples are presented in supple-
mentary Tab. S1.  The quantification of the inocu-
lum brushed from an infected leaf to the healthy 
leaf reveals a wide range of variation in the number 
of conidia in a square centimeter (mean=5403, 
standard error=502, standard deviation=3012). In 
the 36 samples, most of the conidial counts are to 
the left of the mean (kurtosis=0.49). The Shapiro-
Wilk test (W=0.93, p(N)=0.03) suggests the sample 
has a distribution significantly different from Nor-
mal (Supplementary Fig. 2).

Both inocula of P. xanthii, both M1 from the cul-
tivated host (C. pepo) and M2 from the wild host (C. 
radicans), were pathogenic on the same five species 
or varieties of the seven hosts that were infected 
(Tab. 1, Fig. 2).

Tab. 1. Cucurbit hosts for pathogenicity tests with Podosphaera xanthii and pathogenicity of two inocula of Podosphaera xan-
thii, from a cultivated species (MI) and a wild one (M2).

 Species Common name or variety Kind
M1

(C. pepo)
M2

(C. radicans)

1 Citrullus lanatus Jubilee watermelon Commercial1 – –
2 Cucumis sativus Poinsett cucumber Commercial2 + +
3 Cucurbita ficifolia ‘Chilacayote’ ‘Criolla’3 + +
4 Cucurbita pepo

5 Cucurbita pepo

Zucchini squash Commercial2 + +
‘Calabacita criolla’ ‘Criolla’3 + +

6 �Cucurbita okeechobeensis subsp. 
martinezii

Butternut squash Wild4 + +

7 Sechium edule Smooth green ‘chayote’ Commercial5 – –

1  Supplier: Rancho Los Molinos; 2  Supplier: Germinal; 3  Chilchota, Mich.; 4  Xalapa, Ver.; 5  Mercado de abastos, Zamora, Mich. 
(+) = pathogen; (–) = non-pathogenic
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Severity levels 

The first analysis of variance (ANOVA) revealed 
that the five means of severity (PI) caused by M1 are 
not different (P = 0.0929), among the five suscepti-
ble cucurbits (Tab. 2). In contrast, the second analy-
sis of variance suggests that there are differences 
between the five means of infection severity (PI) 
caused by P. xanthii from the wild host M2 (P = 
0.0045). The mean value of the infection was signifi-
cantly lower in C. ficifolia with respect to C. 
okeechobeensis subsp. martinezii and C. pepo 
(Tab. 3).

The five analyses of variance for the paired com-
parisons of the means of the severity values (PI) 
caused by M1 with respect to M2 showed that there 
are significant differences in only two of the five 
susceptible cucurbits (Fig. 3). The severity (PI) 
caused in C. ficifolia by M1 was significantly higher 

than the PI caused by M2 (P = 0.0065). The severity 
(PI) by M2 in C. okeechobeensis subsp. martinezii 
was higher than by M1 (P = 0.0002).

Discussion

This study with digital images has revealed the 
advantage of using a widely available technique to 
quantify the pathogenicity and virulence of Po-
dosphaera xanthii. Although a destructive method 
was used, since the digital images were taken from 
detached leaves, it could also be implemented on 
leaves in situ to monitor the progress of the infec-
tion. The area quantification used does not depend 
on the different tones in the digital image by pixel 
islands and measuring in the visible spectrum 
(Barbedo 2013, Hitimana & Oubong 2014) and in-
visible spectrum (Schneider et al. 2012, Al-Qarallah 

Fig. 2. (A–J) Leaves of cucurbits susceptible to Podosphaera xanthii. Each photograph is representative of the average values of 
severity levels (PI). Above: species infected with inoculum of the cultured host Cucurbita pepo (M1). Bottom: species infected 
with the inoculum of the wild host C. radicans (M2). (A, F) Cucurbita ficifolia; (B, G) C. okeechobeensis subsp. martinezii; (C, H) 
C. pepo var. ‘criolla’ (D, I); C. pepo var. ‘zucchini’ and (E, J) Cucumis sativus.

Tab. 2. Analysis of variance and Tukey’s test for the paired comparison of means of severity (PI) of the inoculum of P. xanthii 
from C. pepo (M1) in the five susceptible species.

Hosts C. ficifolia
C. okeechobeensis 
subsp. martinezii

C. pepo (‘criolla’)
C. pepo 

(‘zucchini’)
C. sativus

Cucurbita ficifolia 0.3337 0.9929 0.9999 0.922
C. okeechobeensis subsp. 
martinezii 

2.694 0.16 0.2736 0.0699

C. pepo (‘criolla’) 0.5996 3.294 0.9982 0.9945
C. pepo (‘zucchini’) 0.176 2.87 0.4237 0.9557
C. sativus 1.162 3.856 0.5628 0.9865

Above: values of statistical significance (P = probability of equality). Below: Q values (critical value from Tukey’s table).
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Tab. 3. Analysis of variance and Tukey’s test for the paired comparison of means of severity (PI) of the inoculum of P. xanthii from 
C. radicans (M2) in the five susceptible species.

Hosts C. ficifolia
C. okeechobeensis 
subsp. martinezii

C. pepo (‘criolla’)
C. pepo (‘zuc-

chini’)
C. sativus

Cucurbita ficifolia *0.0133 *0.0034 0.1268 0.1871
C. okeechobeensis subsp. 
martinezii 

4.828 0.9866 0.8681 0.7692

C. pepo (‘criolla’) 5.538 0.7104 0.5887 0.4647
C. pepo (‘zucchini’) 3.46 1.367 2.078 0.9996
C. sativus 3.176 1.652 2.362 0.2845

Above: values of statistical significance (P = probability of equality). Below: Q values (critical value from Tukey’s table). Different 
averages are indicated with an asterisk (*).

Fig. 3. Paired comparison of the severity (PI) caused by the inocula of Podosphaera xanthii, M1 and M2 in the five susceptible 
cucurbits. Below each graph, the statistical significance values (P) obtained with the Monte Carlo Permutation test (MCP) and 
with the T-test (t) in the analysis of variance (ANOVA) are shown. The “equal” or “different” sign is included in the graph depend-
ing on the result of each comparison through each analysis of variance.
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et al. 2017). Therefore, no effects are introduced by 
variations in lighting or non-standardized colour 
capture. The technique used here relies on manually 
tracing infection polygons, leaf perimeters, and 
scale, making it easy to measure areas. Certainly, a 
study remains to be designed to determine the level 
of error in this operation. What has become evident 
in this preliminary experiment is the speed in the 
registration of the areas, so that in future studies 
the number of samples may be expanded. The avail-
ability of the image collection also creates the op-
portunity to repeat the quantitative estimates of the 
infected areas. Therefore, the use of this method of 
quantification of infected areas with the use of dig-
ital images is recommended for later larger studies 
of the pathogenicity of P. xanthii.

This initial study made it possible to detect the 
pathogenicity and virulence of P. xanthii in seven 
species and varieties of Cucurbitaceae. The two in-
ocula of this fungus, one from the cultivated species 
(M1) and the other from a wild one (M2), were path-
ogenic in the same five cucurbits. In P. xanthii, sev-
eral pathotypes have been identified according to 
the variation in its infective capacity on different 
hosts. Our results suggest that the two evaluated in-
ocula could belong to the same pathotype since they 
infect the same five species. The differences ob-
served in the severity of virulence measured with 
the infected area suggests that the two inocula 
could correspond to different races. However, to 
corroborate these inferences, more pathogenicity 
tests need to be carried out including different cul-
tivars of Cucumis melo. This species has a great va-
riety of genotypes, some of which are included in 
the standard set of differentials to determine patho-
types and races of powdery mildew in cucurbits 
(Lebeda et al. 2008, Hong et al. 2018).

Another informative result is that the two inoc-
ula of P. xanthii (M1 and M2) did not infect two cul-
tivated species, C. lanatus (watermelon) and S. ed-
ule (‘chayote’). This result does not appear to be re-
lated to the possible lack of consistency in the 
amount of conidia transferred by the brushing 
method. Our quantification of the conidia input to 
infect leaves suggest that the brushing method 
transfers a minimum of 1000 conidia/cm2 (Supple-
mentary Figure 2), which was enough conidia to 
cause an infection in the other hosts. Rather, the ex-
planation may be found in the interaction of possi-
ble races and the two uninfected hosts. In some 
Asian countries and in the USA, there are records of 
powdery mildew in both crops caused by P. xanthii 
(Farr & Rossman 2021). Recently, two races (1W and 
2W) of a P. xanthii pathotype were discovered in the 

United States, capable of infecting C. lanatus very 
aggressively (Davis et al. 2001, 2007; Tetteh et al. 
2010). These two races have dispersed throughout 
different regions of that country (Kousik et al. 2019). 
In Mexico, there are no records of significant out-
breaks of powdery mildew in C. lanatus crops. 
Therefore, the fact that this cucurbit was not sus-
ceptible to M1 and M2 could indicate that these in-
ocula are different from the two American races 
(1W and 2W). The absence of infection in S. edule 
could also suggest that the two inocula used in the 
present study (M1, M2) are also different from the 
powdery mildew caused by P. xanthii on S. edule 
documented in other parts of the world (Farr & 
Rossman 2021) and another inoculum of P. xanthii 
registered in Mexico. In a recent exploration, a 
small P. xanthii infection was found in a S. edule 
plant in a commercial crop from the state of Verac-
ruz, but not in other parts of Mexico (Gregorio-Cip-
riano et al. 2020). Powdery mildew in S. edule is 
common in Mexico and is considered one of the 
most frequent diseases of the crop (Olguín-Hernán-
dez et al. 2011). But in this country the causal agent 
is Neoerysiphe sechii R. Gregorio-Cipriano and D. 
González (Gregorio-Cipriano et al. 2020). The ab-
sence of infection in C. lanatus and S. edule plants 
inoculated with P. xanthii (M1 and M2), present in 
central-western Mexico (Chilchota, Michoacán), 
could indicate that these inocula are different from 
powdery mildew caused by P. xanthii in other parts 
of the world.

The severity (PI) caused by M1 was not different 
between the five inoculated hosts in this study. The 
level of severity does not depend, apparently, on the 
differences between these species and varieties of 
cucurbits. There was no discrepancy between the 
four cultivated species and the inoculated wild spe-
cies. In contrast, the severity of P. xanthii from the 
wild host (M2) varied among some of the cucurbits. 
The paired comparisons of the PI values of M1 and 
M2 in each species or variety of cucurbits allowed 
us to detect that the severity is different in two of 
the five susceptible cucurbits. Podosphaera xanthii 
from the cultivated host (M1) caused greater dam-
age in C. ficifolia, a cultivated species, than the in-
oculum from the wild host (M2). On the other hand, 
the inoculum from the cultivated host (M1) caused 
less damage in the wild species (C. okeechobeensis 
subsp. martinezii) than the inoculum of P. xanthii 
from the wild host (M2). This suggests a distinctive 
virulence between both inocula of P. xanthii. How-
ever, to determine whether they are two physiologi-
cal races, it is necessary to use monosporic cultures 
of the fungus and measure its severity in the differ-
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ential plants of Cucumis melo as conventionally 
used for this purpose (Lebeda 2016, 2018).

Paired comparisons of the means of the PI values ​​
of M1 and M2 were only significant in C. sativus and 
C. okeechobeensis subsp. martinezii. The results 
showed that the maximum percentage of infection 
area (PI) obtained for M1 was 58 % in C. sativus and 
45 % for M2 in C. okeechobeensis subsp. martinezii. 
In all cases, the observed severity levels of both P. 
xanthii inocula are interpreted as low to moderate 
in the five susceptible cucurbit species. The severity 
values ​​observed are at a level equal to or less than 
level three (40–69 % of PI) of the five established by 
Davis et al. (2001) visually, in six replicas of the to-
tal plant of C. lanatus (leaf, stem and cotyledon) of 
approximately 100 accessions. This quantification 
with digital images allowed acquiring results com-
parable to those obtained by Davis et al. (2001) with 
visual methods. Clearly, it is better to use a quanti-
tative technique to estimate the pathogenicity and 
virulence of Podosphaera xanthii.
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Lebeda A., Křístková E., Sedláková B., McCreight J.D., Coffey 
M.D. (2016) Cucurbit powdery mildews: methodology for 



Sydowia 74 (2022)� 285

Gregorio-Cipriano et al.: Quantification of Podosphaera xanthii from digital images

objective determination and denomination of races. Euro-
pean Journal of Plant Pathology 144: 399–410. 
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Tab. S1. Variation of the inoculum brushed from an infected 
leaf to the healthy leaf estimated by 36 counts of conidia in a 
square centimeter.

N

Min

Max

Mean

Std. error

Stand. dev

Median

Skewness

Kurtosis

Coeff. var

36

1134

13300

5403.806

502.0113

3012.068

4729.5

0.888169

0.492538

55.73975

Supplementary Fig. 1. Color version of Fig. 1

Supplementary Fig. 2. Histogram and normal fit of the number of conidia in a square centimeter to quantify the inoculum 
brushed from an infected leaf to the healthy leaf. The frequency distribution of 36 counts is significantly different from Normal 
(Shapiro-Wilk test W=0.93, p(N)= 0.03).


